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Certification 
 
To become certified on this piece of equipment you will need to attend a training class.  
By the end of the class, you will be able to: 
 
 -Know how to safely operate the Graphtec Vinyl Cutter. 

-Understand basic design functions of CorelDraw as it relates producing vinyl   
creations. 

 -Know how to prepare and apply vinyl stickers for immediate or future use. 
 -Basic information about types of vinyl—Removable, Permanent, Heat Press 
 
To sign up for a training session please inquire at the front desk. 
 

 
Reservations 
 
To reserve this piece of equipment you will need to first be certified on this equipment.  
After you attended a training for the vinyl cutter, you may sign up for a time slot to use 
the equipment.  Inquire at the front desk for more information.   
 

 
Additional Resources & Online Training: 
 
 
Graphtec’s Manufacturers’ Manual for the Vinyl Cutter/Plotter can be accessed at:  
http://nlc.nebraska.gov/grants/InnovationStudios/Documents/ce6000_series_user_manual.pdf 

 
 
Additional CorelDraw instructions may be accessed at:   
https://nlc.nebraska.gov/grants/InnovationStudios/Documents/CorelDRAW_SOPrev08-15-18.pdf 

 
 
Online Training--While the Library Innovation Studios project was active in Nebraska, 
an online training course for the Graphtec Vinyl cutter was created (along with trainings 
on other makerspace machines).  Makers and trainers may still access the courses at:  
https://my.nicheacademy.com/innovationtraining 
 
Those who want to access the Library Innovation Studio lessons on Niche Academy, 
must first create a free personal account with a login. To create an account you enter a 
first name, last name, and email address.   
 
Those that go through the entire lesson for any of the subject matters/machines, will be 
provided a certificate of completion.  Nebraska Library Commission staff will be able to 
view a list of who has completed the lessons, but will not be using or sharing email 
information.  
 

 

http://nlc.nebraska.gov/grants/InnovationStudios/Documents/ce6000_series_user_manual.pdf
https://nlc.nebraska.gov/grants/InnovationStudios/Documents/CorelDRAW_SOPrev08-15-18.pdf
https://my.nicheacademy.com/innovationtraining
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Key Concepts 
 
Raster vs. Vector 
 
Two-dimensional images can be created using two different methods, either a raster or 
a vector.  Raster images are composed of pixels and are capable of capturing a lot of 
detail—photographs are examples of raster images.  Vector images are composed of 
perfect mathematical curves and can be infinitely scaled without a loss of quality—text 
in a text editor is an example of a vector image.   
 
The vinyl cutter requires vector drawings to operate correctly.  Raster images will not be 
visible to the vinyl cutter and must be converted to vector drawings prior to cutting. 

 
 
CorelDraw Design Software 
 
CorelDraw is an image manipulation program, used to create and modify 
images.  CorelDraw focuses on vector images and may be used to convert raster 
images into vector images in order for the vinyl cutter to be able to cut the image.  For 
more on CorelDraw see Pages 13-16 and 24-31. 

 
Why is the Graphtec machine sometimes referred to as a Cutter/Plotter? 
Although you may have only seen the Graphtec used to “cut” vinyl, the “Tool Holder” on 
the machine can either hold a blade or it can hold a special plotting pen that “draws” on 
the inserted material.  That is why the machine is both a cutter and a plotter. 

 
Vinyl Decals/Stickers 
 
Vinyl decals are decorative stickers that can be applied to a variety of objects.  Designs 
are sent from CorelDraw to the vinyl cutter using another program called Cutting Master 
4.  The design is cut into the thin layer of vinyl but not into the paper support 
backing.  After the machine has cut the design, the waste vinyl must be removed in a 
manual process called weeding.  Transfer paper/tape is applied to the vinyl to assist in 
the successful application or transfer of the decal.  Just before applying the decal, the 
paper support backing on the vinyl is removed, exposing the sticky side of the vinyl.  
The decal is applied to the intended surface using a burnisher that is rubbed over the 
sticker to help adhere it to a surface.  Once the vinyl sticker is properly secured, the 
transfer tape is removed at a sharp angle.    
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Reference Sheet 
 
Approved Materials: 
 

Thin paper and vinyl.  Vinyl can be removable, permanent, and heat press vinyl.  
Check with the makerspace to see what types of vinyl they might have for sale. 

 
FYI: Vinyl and transfer tape used in the Library Innovation Studios Project 
included: 
   TransferRite Ultra 582U Medium Tack Transfer Tape (6” & 12” 100-yard rolls) 
   Removable Indoor Vinyl:  Oracal 631M Removable Vinyl (M is for matte finish) 
   Permanent Vinyl: Oracal 941 Premium Cast Vinyl 

    Note: Vinyl was purchased in 10-yard rolls—most 15” wide and some 24” wide 
 
Max Cutting Area of Shortest Direction:  Max Media Thickness: 

23.7” (603 mm) (when using 24” Vinyl)          .01” (0.25 mm) 
 
Machine Accessories: 
 

Retractable Cutoff knife 
Self-Healing Cutting Mat 
Burnisher 

Craft Knife (X-Acto Knife) 
Dental Tools  
Transfer Paper/Tape 

 Removable Vinyl 
 
Common Settings: 
  

Heat Transfer Vinyl: Force of 12 
Glitter Vinyl: Force of 15 
Regular Vinyl: Force of 9 

 
Proper Storage Humidity and Temperature Levels: 
 

Vinyl should be stored in areas that are not too cold, too hot, or too humid/damp.  
Relative air humidity between 50% and 60% and temperature around 75°F is 
best.  Do not let the storage area temperature to drop below 64°F and do not 
store vinyl in direct sunlight.  Do not have vinyl stored too close to radiators or 
right next to air vents. 

 
Proper Application Humidity and Temperature Levels: 
 

Generally, vinyl should never be applied at temperatures below 50°F.  However, for 
best application results, surface and ambient temperatures should be between 65°-
75°F; with humidity levels resting between 50 - 70%. Newly applied graphics should 
remain in the application environment for at least 24 hours to promote uniform 
adhesion characteristics. A significant change in temperature should be avoided 
during the first 24 hours after the application is initially complete, as this may result in 
the material lifting or popping up in complex curved areas. 
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Application of “Removable Vinyl” on Walls—Do’s and Don’ts: 
 

Do’s 

 Choose a smooth, non-porous surface. 

 Apply vinyl in temperatures between 65 and 75 degrees F if possible – never 
colder than 50 degrees. 

 Works well on gloss and semi-gloss paint finished. 

 If you need to clean the wall, use mild soap and water and make sure to allow time 
for complete drying.  

 Allow up to 24 hours of bonding time before you remove the application tape from 
the vinyl if your wall is painted with “Low or No VOC” paints that are now on the 
market, as this paint has lower levels of vinyl adhesive bonding attributes. 

 
Don’t 

 Don’t apply to textured surfaces. 

 Don’t apply to uncured paint (curing takes at least 4 weeks). 

 Don’t apply to dusty or dirty surfaces. 

 Don’t apply in rooms with less than 50% humidity for the first 24 hours. 

 Don’t clean walls with isopropyl alcohol. 
 
Workflow: 
 

 Load vinyl into vinyl cutter machine 

 Create design in CorelDraw or other software 

 Machine cuts vinyl 

 Slice off machine-cut vinyl with retractable cut-off knife 

 Cut apart vinyl stickers if multiples were cut/created 

 Weed unwanted vinyl off of backing and discard 

 Apply transfer tape to front of weeded vinyl 

 Remove backing from vinyl exposing sticky back-side of vinyl 

 Affix exposed sticky-back side of vinyl to surface (wall, jar, notebook, etc.) 

 Secure to surface by rubbing burnisher over transfer tape side of your sticker 

 Carefully remove transfer tape at a sharp angle 

 Smooth newly applied vinyl with burnisher if needed 

 Remove vinyl roll from machine, and secure the end with painter’s tape 

 Return all tools and vinyl rolls used and dispose all waste that was created. 

 Pay for vinyl (if applicable) 
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Graphtec Vinyl Cutter 
 
Training Materials, Accessories and Software: 
 

Graphtec CE6000-60 Cutter/Plotter 
Retractable Cutoff Knife 
Removable Vinyl 
Self-Healing Cutting Mat  

Craft Knife (X-Acto Knife) 
Dental Tools/thread ripper (safer) 
Transfer Paper/Tape 
Burnisher 

 
Training Overview 
 

Makers will learn how to operate the cutter/plotter, how to load material, and how 
to process a sticker from weeding to affixing a sticker on a surface.  

 
Safety 
 

 Hair and loose clothing may be caught in the cutter head.  Long hair should be 
tied back, long necklaces removed, sweatshirt strings tucked in, and flowing long 
sleeves rolled up. 
 

 Keep your hands away from the machine when parts of the machine is in motion. 
 

 Be aware that the machine’s tool holder that moves side to side during cutting, 
has a sharp blade pointing downwards.  Avoid being cut by keeping your hands 
away from that part.  Additionally, makers should NEVER remove the 
machine’s tool/blade holder.  (Makerspace staff should also avoid removing 
that part unless an adjustment is called for.  When that occurs, Makerspace staff 
should refer to the “Makerspace Only” section on how to do so properly.) 

 

 Take care to not cut yourself or others on the retractable cutoff knife that is used 
to cut off the vinyl from the roll after the machine has cut your design into the 
vinyl. 
 

 Take care to not cut yourself or others on the X-Acto knives that can be used in 
the weeding process (the removal of waste vinyl from around the sticker).   
 

 If makerspace staff (or makers with permission) replaces the X-Acto blades with 
broken tips for new blades, make sure to properly dispose the used broken 
blades into a “Sharps” container (typically found in public restrooms).  Do not 
dispose blades in wastebaskets without taping them between two cardboards or 
some other method to protect hands that might be later inserted into trash 
receptacles. 
 

 Be aware that the makerspace has “safety weeders” for younger makers or those 
makers that do not want to weed vinyl the stickers with sharp blades.  Alternative 
weeders that are less dangerous include dental picks and the point of a thread 
ripper.  Some pointed cuticle utensils also make fine weeding tools. 
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Machine Layout

 
 
Tool Carriage (Head) 

Note:  It is rare that makerspace 
staff will ever need to adjust the 
depth of the blade unless makers 
are switching to a thicker or thinner 
vinyl.  The blade is already adjusted 
to cut through the vinyl without 
cutting through its paper backing. 
Only makerspace staff are allowed 
to adjust the machine blade. 

Tool (blade) Holder 
 

 
 

 

 
 

 

 
Cut Off Groove  

 
Use this grove to cut vinyl 
straight across with retractable 
cut-off blade  

Photos Showing Select Parts Below 

Power Switch is located on 
the left side of the machine 
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The two wheels can be adjusted by moving them side to 
side to accommodate different widths of vinyl/material.  
Both wheels must be on the vinyl to push and pull the 
vinyl while computing and cutting and above a grit roller 
Located below the blue lines (See Page 10). See next 
page for more complete information on setting the push 
rollers/wheels. 
 

One of two “Push Roller/Wheels” that  
hold down material (seen on front of machine) 

On the back of the 
machine is the “Media Set 
Lever” that lifts and lowers 
the “Push Rollers” (the 
wheels the holds down or 
releases the vinyl).  

Lift the lever to lower the 
wheels to hold the 
material.   

Lower the lever to raise the 
wheels to release the 
material/vinyl.  
 
NOTE: When the vinyl 
cutter is not in use, the 
wheels should be in the 
“up” position—lever down. 
 

 
 

 

Control Panel on the Vinyl Cutter/Plotter 
 

 
 
More about each of these buttons can be found in the Manufacturers’ Manual by going 
to:  http://nlc.nebraska.gov/grants/InnovationStudios/Documents/ce6000_series_user_manual.pdf 

 

http://nlc.nebraska.gov/grants/InnovationStudios/Documents/ce6000_series_user_manual.pdf
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Proper Positioning of the Push Rollers/Wheels: 
 

 
  

The Graphtec Vinyl Cutter machine has two Push Rollers (the adjustable wheels you can see) 
and four Grit Rollers that are recessed into the machine and sit under the vinyl.  The Grit 
Rollers cannot move from side to side, but you can tell where they are located because 
Graphtec placed the Grit Roller Position Guides (the blue lines) above the four grit rollers that 
are housed in the machine for your reference.   
 
IMPORTANT: In order for the machine to operate correctly, each of the two Push 
Rollers/wheels must be positioned above one of the Grit Rollers and on top of the vinyl/material 
you will be cutting.  The Push Rollers should be no closer than 2/3-inch from the left and right 
edges of the material.  
 
So basically the right wheel should be about an inch or so in from the right side of the vinyl and 
that wheel should be over the right longer grit roller or somewhere under that longest blue line.  
The left wheel should be about an inch in from the left side of the vinyl and under one of the 
short blue lines.  If you are using 24” wide vinyl, position the left wheel under the most left blue 
line.  When using 15” wide vinyl, position the left wheel under the second from the left blue line.  
When using 12” wide vinyl, position the left wheel under the third from the left blue line.   
 

  

Grit Roller Position Guides 

“Movable” Push Rollers/Wheels 
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Remove Vinyl Roll 
 
To remove the roll of vinyl from the machine, first release the locked wheels by lowering 
the “media set/lock lever” on the 
back of the machine (Figure 1).  
Rotate the roll of vinyl to retract the 
vinyl from the machine.  As you lift 
the roll from the machine, take care 
to not unravel or loosen the vinyl on 
the roll.   
 
Before storing the roll of vinyl, 
tighten the layers if they are loosely 
rolled, and secure the end of the 
vinyl with a piece of painter’s tape 
(in most cases you can reuse the 
used piece of painter’s tape. 
 
  

 

Load Vinyl Roll 

 
1. Once you have the vinyl roll you would 

like to use, remove the tape securing 
the roll. So that you do not lift the vinyl 
off of its paper backing at the cut end 
of the vinyl, make sure to remove the 
tape by first removing the end of the 
tape that is attached to the top layer of 
vinyl first. Then once the vinyl end is 
no longer attached to the rest of the 
roll, you may continue to peel off the 
remainder of the tape that is attached 
to the vinyl that lies underneath.  (The 
issue that occurs if you peel the other end of the tape up first, is that you tend to 
separate the vinyl from its backing at the cut end of the vinyl.)  Stick the end of the 
tape off the side of the machine so you can find it later when you need to put the roll 
away.  Place the roll of vinyl on the two bars on the back of the vinyl cuter so that it 
unspools from the top with the cut edge facing the machine (Figure 2).   
 
Note: The manufacturer’s instructions instruct you to do more than simply sit the roll 
of vinyl on the two bars. However, simply setting the roll on the two bars without 
trying to “secure” the roll actually works better. Using the rod’s sliders to secure the 
roll can cause unwanted issues. 
 

Figure 1 – Lowering the Media Set Lever 
Shown on the Backside of the Machine 

Figure 2 – Loading Direction and Placement 
(this is back side of the machine) 
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2. Unlock the “push rollers/wheels” by 
pressing down on the “media 
set/lock lever” (Figure 1 on previous 
page).  Feed the vinyl through the 
plotter and make sure the vinyl is 
under both push rollers/drive wheels 
(slide the wheels along the rail as 
needed when the back lever is in the 
down position—not locked).  Ideally, 
the wheels should be about 3/4 inch 
inside the ends of the vinyl.  Each 
wheel MUST also be under a “blue 
grit roller indicator line” so that the 
wheels are above the hidden grit 
rollers in the base of the machine.  This is described in more detail on Page 10.  Pull 
through about 6 inches of vinyl and let it overhang (Figure 3). This overhang is 
important so that the material is positioned over the media sensor.  The machine will 
retract the vinyl later.  

 

3. Check that the vinyl is properly loaded into the machine:   
 

 The edge of the vinyl should run parallel to the raised lines in 
the curved front of the machine (Figure 4). 

 The vinyl should be under both push rollers/drive wheels.  

 The drive wheels are located under the blue wheel locators 
(Figure 3).  The wheels can be moved by sliding them left 
and right when the lock lever is in the down position—not  
locked. 

 
 
4. Engage the “push rollers/wheels” by pulling up on the “media set/lock lever on the 

back of the machine to secure the vinyl. 
 

5. The machine can now detect that the vinyl is in place.  On the control panel’s 
screen, it asks where we want to set the “Zero” position.  We will press “1” to select 
“FRONT EDGE” of the vinyl (Figure 5).  
The “Tool Carriage/head” will move side 
to side to detect the right and left edges 
of the vinyl and will move the vinyl in 
and out to detect the front edge.  It will 
automatically retract the vinyl to 
minimize waste material.  The machine 
is now loaded and we are ready to go 
over to the computer to work on our 
design.  

 
 

Figure 3 – End of Loaded Vinyl as 
viewed from the front of the machine 

Figure 5 – Control Panel: Select “1” 
button for front edge position 

Wheels under the blue 
lines & on top of vinyl 

Figure 4 – Parallel raised lines 
to help you make sure the 
vinyl is coming in straight 
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Prepare Design File using CorelDraw 
 
You will find some CorelDraw basics and tools discussed further in the Multi-Colored 
Sticker section on Pages 24-31.  Here is a quick index of what you can find there: 

                           Page # 
   How to Click, Right Click, Middle Click, Click and Hold & Scroll  24 
   Using the Pick and Freehand Pick Tools     24 
   How to Zoom, Pan, Copy, Paste      25 
   How to Create a New Document      25 
   Considerations When Selecting an Image     26 
   Colors Tab (generally not needed for one-color stickers)   28 
   Identifying “Smoothing” issues       29 
   How to Ungroup, Combine, Break Apart, Weld    30 
   Crop, Knife (to draw/extend lines), Eraser Tools    31 
 
 
Tip: Loading the vinyl first will help you in the design phase so make sure that step is 
completed. 
    
 
On the computer, open CorelDraw and start a new file. 
On the Welcome screen click Get started> New 
document -OR- in the application window, click File > 
New (Figure 6).  Select “CorelDraw default” for the 
destination from the Preset destination list box. 
 
In order for the vinyl cutter to cut a design it must be a 
‘Vector’ graphic.  The vinyl cutter does not recognize 
‘Raster’ graphics, which are made up of pixels. There 
are two options to convert an image from a raster to a 
vector.  One option is to manually recreate the design 
using CorelDraw’s drawing tools.  This option can be 
more accurate to the original design but it takes a lot of 
time and expertise.   
 

 

CorelDraw Trace Guide 

“Tracing” (the easier conversion option), is a function in 
CorelDraw that lets you trace bitmaps to convert raster 
images to fully editable and scalable vector graphics.  
You can trace artwork, photos, scanned sketches, or 
logos and then easily integrate them into your designs. 
 
Begin by pasting or importing an image into an artboard.   
More can be learned about selecting an image that works  
well on Page 26. 
  

Figure 6 – CorelDraw Options 
under “File” Tab – Showcasing 
“New” and “Import” 
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Copy/Paste 

Right clicking on an image and selecting “Copy” places the picture on the computer’s 
virtual clipboard, right clicking on the artboard in CorelDraw and selecting “Paste” will 
add the image to the artboard.  Not all images can be put onto the artboard in this 
way.  If this fails move onto the “Import” option discussed below. 

 
Import 

Save the file to the computer (either the desktop or a flash drive) and then go to your 
CorelDraw file.  Select “File” and then “Import” (Figure 6).  Navigate to your file and 
select “Import.”  A single left click will place the image on the artboard; or by left 
clicking and dragging you can specify the size of the object. 

 
With the object now on the artboard and the object selected, click “Trace Bitmap” in the 
upper toolbar (Figure 7).  There are different preset Traces that can be chosen based 
on the type of image you are tracing.  General attributes of the options are as follows: 
 

Quick Trace – A one-step command. 

Centerline Trace – Uses unfilled closed and open curves (strokes) and is suitable 
for tracing technical illustrations, maps, line drawings, and signatures.  The 
centerline trace method offers two preset styles: one for technical illustrations (for 
black and white sketches with thin faint lines) and another for line drawings (for 
black and white sketches for thick, prominent lines). 

Outline Trace – Uses curve objects with no outlines and is suitable for tracing 
clipart, logos, and photo images. The outline trace method offers several preset 
styles suitable for a variety of images: 

 Line art (for black and white sketches and illustrations) 

 Logos (for simple logos with little detail and few colors) 

 Detailed logo (for logos with fine detail and many colors) 

 Clipart (for ready-to-use graphics)  

 Low Quality Photo images (for low quality or fine detail you want to ignore) 

 High Quality Phot images (for high quality, highly detailed photos) 
 

 
 

Figure 7 – Trace Bitmap in CorelDraw’s Toolbar 
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In our example featuring the Library 
Innovation Studio logo, we choose “Outline 
Trace” from the Trace Bitmap drop-down, 
and then “Detailed Logo” because we 
choose a fairly-detailed graphic (Figure 8). 
 
Each trace will show the original image (top 
picture) and a preview of the traced image 
(bottom picture).  (When your images are 
taller than they are wide, these will be right 
and left pictures.)  No matter which Trace 
option you selected, you can still adjust your image by using the “PowerTRACE” dialog 
box (left side of Figure 9).  By adjusting the Detail, Smoothing, and Corner Smoothness 
‘sliders’ you may find more or less appealing results.  As you adjust the sliders, notice 
that the bottom (or right) “traced” picture either improves or gets worse depending on 
those adjustments.  You will find there are some details that do not trace well.  Overly 
complicated designs or small text will often be ignored by the Trace function. 
 
For best results with the Vinyl Cutter, make sure to remove the background color from 
the image.  Under options, select both “Remove Background” and “Remove color 
from entire image.”  This will keep the vinyl cutter from cutting the same line twice. A 
common problem is when the software creates a ‘line on top of line’ because it is tracing 
each color. We can eliminate this double line that is created by the background color 
when we remove the background (in this instance the white color). A grey and white 
checkered background appears where it had been white to indicate there are no objects 
in that area.  If the entire background is not checkered, you may “Shift” Click on the 
remaining background sections to remove those as well. 

 

 

Figure 9 – PowerTRACE Screen Showing Sliders and Options 

 

Figure 8 – Selected 
Outline Trace, then 
Detailed Logo 
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Using the menu, you can also elect to eliminate a specific color by checking the specific 
color box and then using the eyedropper tool to the right of that, to select a color to 
remove from the design. 
 
For those who might want to try some new things, makers can also move from the 
“Settings” tab to the “Colors” tab.  There you can merge colors if you want to.  You can 
also select a specific number of colors that you want and the system will try to merge 
the design into that many colors. More on the Colors tab on Page 28. 
 
When you are happy with the bottom (or right) image, click “OK” in the bottom bar.  
Doing so converts the design to a vector design and it sends the edited design to the 
vinyl cutter’s Cutting Master 4 software.  However, it will only be sent to print on a single 
color and not on multiple colors as shown in our example logo image. For training, we 
will be only cutting a single-color sticker. 
 
Dividing cut lines for the different colors and layering your sticker with more than one 
color is an entirely different lesson.  For more on multi-colored or multi-layered stickers 
see Pages 24-31. 

 
Files may be adjusted for size and multiple copies in CorelDraw or you can do that in 
the “Launch” screen (the next step that follows on the next page).   
 
To save your drawing, click on File > Save as. Type a filename in the File Name box.  
Locate the folder where you want to save the file.  Remember, files saved on 
makerspace computers may not be there when you come back to the workstation.  If 
you want to save a file for a return visit, use a cloud-based location or a removable USB 
drive. 
 
 
 
 
 
 
 
 

  

For more on CorelDraw instructions that is a companion piece to the Vinyl Cutter SOP, refer to:  

https://nlc.nebraska.gov/grants/InnovationStudios/Documents/CorelDRAW_SOPrev08-15-18.pdf 

 

https://nlc.nebraska.gov/grants/InnovationStudios/Documents/CorelDRAW_SOPrev08-15-18.pdf
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Final Launch Selections/Send File to Cutter 
 
 
1. Send the design to the Cutting Master 4 software for 

final selections by selecting Cut/Plot (CM4) from the 
Launch dropdown menu (Figure 10). 

 
 
 
 
 
2. This action will open two windows.  The window entitled 

Cutting Master 4 will show the jobs the vinyl cutter is 
working on (Figure 11).  This software enables the 
plotter to operate correctly.  The user does 
not need to make any selections in this 
window, however the window cannot be 
closed otherwise the cutter/plotter will not be 
able to operate correctly.  You should 
“minimize” this window and leave it 
working in the background. 

 
 

3. The other window that opens is entitled “Cut/Plot” window. The Cut/Plot window 
will allow you to adjust the settings (Figure 12). 
 

 
 
 

Figure 12 – 
Cut/Plot Window 

Current Job 

Figure 10 – How to Launch 
Cutting Master 4 

Cutting Master 4 

 Figure 11 – Minimize Window—DO NOT Close Cutting Master 4 
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4. In the left hand side of the Cut/Plot 

Window, there are multiple tabs to 
change the properties of your job.  The 
first tab is “General” (Figure 13).  
Selections on that tab allows you to 
change the size of your media (the 
vinyl), the size and position of the job, 
and the number of copies of your design 
to lay out.  On the screen’s right side is 
a representation of your design. 

 
 
5. The first area under the General Tab is “Media Size” area (Figure 14).  There are 

two ways to enter the size of your vinyl loaded in the machine.  The best way (if you 
have already loaded your vinyl and gone through the steps on Pages 11-12), is to 
click on the red question mark button. Doing so imports the information from the 
vinyl cutter’s measurements into the 
Cutting Master 4 (CM4) interface.  
Failure to click on the red question 
mark can result in incomplete cut 
jobs.  The alternative option is to 
enter the material size in the “User 
Defined” area in the horizontal and 
vertical media size boxes. 

 

6. The Job Size area (Figure 15) allows you to 
adjust the size of your graphic either by 
inches or by a percentage increase/decrease.  
Check the “Proportional” box if you want to 
make sure you do not change the proportions 
of your graphic.  When that box is checked, 
you only need to change the width or height 
and the other one will be automatically adjusted to keep your graphic in the same 
proportions as in the original design.  Checking “Fit to media” (and Proportional) will 
automatically resize your graphic as big as it can be and still fit your material.   

 

 

7. You can click and drag your design 
if you wish or you can use the 
Position area (Figure 16) to change 
the location of the design on the 
sheet.  Many put the design in the 
lower right hand corner.  Keep in 
mind that some vinyl have punched 
holes at the two ends (those holes are not needed for this vinyl cutter).  Make sure 
your design does not overlap those pre-punched holes.  The user may also rotate 
the design or mirror the design in this box. 

Figure 14 – Media Size Selections 

Figure 15 – Job Size Selections 

Figure 13 – General Tab of the Cut/Plot Window 

Figure 16 – Position options to 
include “Rotate” and “Mirror” 
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Why Rotate Your Design? – To save vinyl you might also consider “rotating” your 
design.  Let us assume your design is a dog that is 10 inches tall and 4 inches wide 
and you only need to print one copy.  You could lay your dog down on its side so 
you only use up just over 4 linear inches of vinyl rather than just over 10 inches if 
you do not rotate your design.  To rotate your design click on the “Man” drop-down 
graphic (Figure 16), and click on the man lying on his side to rotate the design 90 
degrees.  
 
When Should you Mirror Your Design? – There are instances when you will want 
to mirror your design.  If a business would like to have a vinyl graphic that shows 
their store hours and they want to place that on the inside of their glass door so 
they it can be read from the outside, they will want to mirror their design.  Use the 
backwards “F” button to mirror the image (Figure 16).   

 

8. The Copies area allows you to layout 
multiple copies and determine how far 
apart the copies should be from each 
other (Figure 17).   
 
Why Make Multiple Copies? – If you only need one copy of the design…should 
you still make multiples?  When you cut off the vinyl roll to remove your machine-
cut images, you will be cutting the vinyl off in a straight line across the entire width 
of the vinyl.  This sometime allows you to print multiple stickers without wasting 
vinyl.  Let us assume your final design is 4” x 4” and you are using 15” wide vinyl.  
You might as well create multiples of your design in a horizontal row so that if you 
have trouble weeding or while affixing your sticker, you have additional images cut 
and ready without wasting additional vinyl.  In this example, you would have room 
for three designs in your row.  

 
9. Typically, makers will only use the selections described above under the first tab.  

The remaining tabs allow for advanced settings and producing designs that are too 
large to fit on one width of vinyl, (a process called tiling).  This document does not 
cover these additional tabs. 

 
10. Once you are happy with your work piece—size, location, number of copies, etc., 

send the job to the cutter by pressing “Send” in the lower right hand corner of the 
Cut/Plot Window.   

 

Note:  If you need to “Pause” or “Quit” the job, hit the Pause/Menu button on the 
machine’s control panel.  On the screen, it will read, “Job is Interrupted.”  As 
indicated on the screen, push ‘1’ to Continue Job or ‘2’ to Quit Job.   
 

11. Once you press “Send,” the cutter/plotter will begin cutting your vinyl.  Keep your 
hands away from the moving parts.  When the machine if finished cutting, the cutter 
head will stop moving and the screen on the machine’s control panel will return to 
the main menu. 

Figure 17 – Laying out multiple copies 
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Process the Vinyl and Affix the Sticker Art 
 
1. Before you can cut off the portion of 

the vinyl that contains your freshly 
cut design, you will need to move 
the vinyl forward so as not to cut in 
the middle of your design.  There 
are two ways to advance the vinyl 
forward.  You can use the “Down 
Arrow” on the machine’s control panel (Figure 18), until the newly cut design is 
completely past the “cut-off groove” in the machine. (If you overshoot your mark, you 
can use the “Up Arrow.”  It is hard to see the cut design in the vinyl, so make sure 
the entire work piece if below the “slice groove.” (The other way to extend the vinyl is 
to unlock the wheels by pressing down on the lever on the back of the machine, pull 
the vinyl out to that location described above, and then pull the lever up to lock the 
vinyl in place. However, using the down arrow described above is easier.) 

 
2. Extend the blade out of the retractable cut-off knife and pull it through the 

machine’s cut-off groove to 
completely cut off the vinyl in a 
straight line (Figure 19).  Take 
care to keep the blade in the 
cutoff slot to avoid cutting the 
machine’s surface.  

(Note: If you are going to cut 
another project with this same 
roll of vinyl roll you will need to 
lift the wheels up with the lever 
on the back, then lower them 
down again, then select ‘1’ so 
the machine can find the front 
edge again.) 

 
 
3. Assuming you are done with the vinyl cutter, remove the roll of vinyl from the 

machine.  To do this release the locked wheels by lowering the “media set/lock 
lever” on the back of the machine.  Rotate the roll of vinyl to retract the vinyl from the 
machine.  As you lift the roll from the machine, take care to not unravel or loosen the 
vinyl on the roll.  Before storing the roll of vinyl, tighten the layers if they are loosely 
rolled, and secure the end of the vinyl with a piece of painter’s tape (in most cases 
you can reuse the used piece of painter’s tape).   

Make sure to leave the wheels in the up position (which means the lever is in the 
down position).  This will ensure the wheels are not pressing down on the drum for 
extended time periods.   

Turn off the vinyl cutter using the switch on the left side and take the detached vinyl 
piece to the self-healing cutting mat (that protects the table from cuts) for 
processing.  Generally, makerspace staff will ask that you leave the computer on.   

Figure 19 – Cut off the Vinyl above the design work by 
pulling your Cut-off Knife through the Cut-off Groove 

Figure 18 – Pushing the “down” 
arrow on the Control Panel 
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4. Keeping the vinyl sheet on the self-healing 
cutting mat, use the craft knife or the dental tool to 
pick up the edges of the waste vinyl for removal 
(Figure 20).  The removal of the waste vinyl is called 
“weeding.”  Continue this process until you have 
removed all of the waste vinyl, leaving only the vinyl 
that is part of the sticker still affixed to its backing. 
 
 
 

 
5. In order to successfully transfer 

your sticker to a surface, apply 
“transfer paper/tape” to the front of 
the sticker to keep all of the 
separate pieces properly aligned.  
Unroll and cut off enough transfer 
paper/tape to more than cover 
your design.  Apply the tacky side 
of the transfer paper/tape to the 
front of your weeded vinyl sticker 
and rub the burnisher over the 
transfer paper/tape a few times so 
that it properly adheres to the vinyl 
(Figure 21).  If the item you will be 
affixing your sticker to is elsewhere, you may stop here. 

 
6. When you are ready to apply your 

sticker, first peel the paper backing 
off the vinyl sticker (the paper 
backing generally features grid lines 
and the brand and type printed on it).  
The best way to peel off the backing 
is to do so at a sharp angle to help 
prevent the vinyl from lifting off the 
transfer tape (Figure 22).  The sticky 
side of the vinyl is now exposed so 
take care not to touch or get dust 
and dirt on your sticker.  At this point, 
the transfer paper/tape is still affixed 
to the vinyl sticker. 

 

7. Press the transfer paper/tape and vinyl up against your desired object while making 
sure the sticker is exactly positioned where you want it before the sticky side of the 
vinyl touches the surface.  Again, rub the burnisher over the transfer paper/tape a 
few times in order to firmly stick the vinyl sticker to the wall, paper, jar or whatever 
other surface is the destination for your sticker. 
 

Figure 20 – The Weeding Process 

Figure 21 – Burnishing transfer paper/tape 
onto the top of the weeded vinyl 

Figure 22 – Remove the vinyl’s 
original paper backing 
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8. Now that you sticker is affixed to 

your surface, slowly peel the 
transfer paper/tape back at a sharp 
angle making sure to leave the 
sticker stuck on its new home 
(Figure 23).  Note:  Removing both 
the vinyl sticker paper backing and 
the transfer paper/tape at a sharp 
(near the surface) angle helps to 
keep your sticker adhered.  When 
you lift either the sticker backing or 
the transfer tape at closer to a 20 to 
90-degree angle, you are more 
likely to lift the vinyl sticker up with 
layer you are trying to peel off. 
 

 
 
 
 
Quick Recap of “Processing the Sticker” for Return Makers 
 

 Weed off the unwanted design – leaving only the sticker parts. 

 Apply Transfer Paper/Tape—tacky side to the front of the weeded vinyl sticker. 

 Rub the burnisher across the Transfer Paper/Tape side. 

 Peel off the sticker’s paper backing at a sharp angle. 

 Stick the sticker to the desired object. 

 Rub the burnisher across the Transfer Paper/Tape side to secure the sticker. 

 Peel off the Transfer Tape at a sharp angle from your newly affixed sticker. 

 

  

Figure 23 – Peeling Transfer Paper/Tape 
off the affixed sticker at a sharp angle 
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Wrap-Up/Cleanup Procedure 

 
1. Turn off the vinyl cutter and unload the vinyl.  To remove the roll of vinyl from the 

machine, first release the locked wheels by lowering the “media set/lock lever” on 
the back of the machine.  Rotate the roll of vinyl to retract the vinyl from the 
machine.  As you lift the roll from the machine, take care to not unravel or loosen 
the vinyl on the roll.  Before storing the roll of vinyl, tighten the layers if they are 
loosely rolled, and secure the end of the vinyl with a piece of painter’s tape (in 
most cases you can reuse the painter’s tape that may have been placed on the 
machine).  Do not use other types of tape or rubber bands to secure the roll as 
these may damage the vinyl.  
 

Make sure to leave the wheels in the up position (which means the lever is in the 
down position).  This will ensure the wheels are not pressing down on the drum 
for an extended period of time.   
 
Note, although it is usually expected that you turn off the vinyl cutter with the 
switch on the left side, generally makerspace staff will ask that you not turn off 
the computer.  When in doubt, just ask.  
 

2. Pick up and dispose the waste vinyl, the removed backing paper, and used 
Transfer Paper/Tape. 

 
3. Retract or cap any blades so they are not exposed when not in use. 

 

4. Return all tools and vinyl to their assigned locations.  Never leave sharp tools out 
where children may find them.   

 

 

 

 

  



24 
 

Designing Multi-Colored Stickers in CorelDraw 

 
Section 1—Basics of CorelDraw 
 
Understanding Clicks & Scroll Instructions 

 

“Click” = Push Left Mouse Button   

“Right Click” = Push Right Mouse Button  

Middle Click” = Push the Mouse Wheel     
 
“Click and Hold” = Press down without releasing  
until the next step is done 

“Scroll” = Rotating the scroll wheel up or down (as directed) by  
resting your finger in the scroll wheel and moving your finger forward (up), 
or back towards you (down)  
 
 

Selecting a Portion of your Image Using “Pick Tool”  
 
There are multiple methods to select one or 
multiple objects on your screen. The simplest is 
the Pick Tool.  As shown in the image to the right, 
the pick tool is located near the top of the left 
menu bar.  You can use the pick tool in two ways.  
You can just click on the object you want to select 
or you can click and hold to then drag your mouse 
over multiple objects to select them all. 
 
 

There is also the Freehand Pick tool you can use by 
clicking the small triangle on the bottom right of the Pick 
tool that triggers the drop-down options.  When using the 
Freehand Pick you click and hold while drawing around the 
objects you want to select. 

To select everything you can press Ctrl and the “A” key at the same time.   
To select multiple specific objects that are not able to be grouped another way, use the 
Pick tool, then while holding the Shift key, click each object you want selected. 

Location of Pick Tool 

Three-Colored 
Cookie Jar Vinyl 
Sticker 
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Zooming  
 
To zoom, scroll up on the scroll wheel.  To zoom out, scroll down. You can also use the 
Zoom Tool and the left click on the drawing to zoom in and right click to zoom out. 
Pressing the “Z” key will also select the zoom tool.  NOTE: The screen will move 
towards your cursor as you zoom. 
 

Panning   
 
Panning is the process of moving around a large or detailed image to view particular 
areas more closely.  There are two ways to pan.  To move around the drawing, middle 
click and hold while dragging your mouse to pan. Alternatively, you can use the Pan 
tool (found in the dropdown of Zoom (see image above), then click and hold while 
dragging your mouse to pan. Pressing the “H” key will also select the pan tool. 
 
Copying 
 
To copy an object you have to first select it. Then you can copy it by doing one of three 
things: pressing CTRL+C, right clicking on the object and click on copy in the menu that 
pops up, or clicking Edit then Copy on the menu that appears.  
 
Pasting 
 
To paste an object you have to first copy it. Then you can paste it by doing one of three 
things: pressing CTRL+V, right clicking on the object and click on paste in the menu that 
pops up, or clicking Edit then Paste on the menu that appears. 
 

 
Section 2—Designing your Image 

 
 
Creating the Document 
 
When you first open CorelDraw, you will usually 
have a welcome screen that you can close if you 
want to. You will then need to create a new 
document by either going to File->New or clicking 
the New Document button that looks like a plus 
symbol in near the top left.  
 
 
 
On the new document, if you do not want the 
machine to cut an unneeded border around 
your image, you should set the size to zero 
height and zero width.  You can change both 
right above the new document button. 
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Finding your Image 
 
Finding the right kind of image can be the most important step in this process. While the 
image in the example below looks simple, it is not.  With the shading and several colors, 
it makes every following step more complicated. The best images will have two or three 
colors and very sharp lines. You can find an image on Google Images or any other 
image browser. Using search terms like clipart, logo, and black and white can help 
focus in on images that are more useful. Copy the image that you choose and Paste it 
in your new document. 
 
Consider these tips in finding an image: 
 

 Images with small dots or pieces will make it harder to weed the vinyl. 
 

 Images with lines that do not connect will need to be edited so that the vinyl is cut 
properly (lines connected), so it can be weeded. 

 

 The more colors your image has, adds to the difficulty and amount of vinyl 
needed for the project. 

 

 Black and white images will be easier to work with than pictures with lots of 
different shadings of colors. 
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Convert to Vectors 
 
First, select the image and then 
click Trace Bitmap.  Then hover 
over Outline Trace then click the 
option that you prefer under that.   
 
Choosing “Detailed Logo” often 
gives you the best results, but you 
can still switch that selection in the 
next screen if you want to try a 
different option. 
 
NOTE: When you bring in an image, you can read how big your image is.   Let us say 
the image your selected is 9” x 11”.  If you know you want your image to be no taller 
than 5 inches, you can change the height to 5” and the other number will automatically 
change in the correct proportion.  Although you learned earlier that you can also change 
the size later in the “Cut Master 4” software, in the case of a multi-colored sticker you 
want to adjust the size of your graphic in CorelDraw.  This is because we are going to 
end up with multiple designs to cut and we will want them to be consistently sized as 
they will become part of a single art piece.  If you resize later, adjust by percentage and 
use that same percentage for each layer. 
 

 
 
After you choose your trace option, a dialog box like the one above opens.  At the top 
left is “Preview.”  This we set to “Before and After.”  This allows you to view both the 
original image and what the results are with the current settings. 
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Here is a better view of the “Settings Tab” options 
in the right side of the dialog box.  As you can see 
at the top, you can still reselect your Trace Type 
and Type of Image to find the best option. 
 
In the middle, are the Trace Controls.  You can 
slide the sliders back and forth to help smooth out 
jagged lines and choose the amount of detail. 
These settings will be different for every picture so 
you will just have to play around for the right 
settings.  It may be hard to see changes in the 
“after” picture as you move the sliders.  Zoom in for 
a better look (using the magnifier with the + sign in 
the top tool bar). Use the Pan tool to check if you 
need to do more smoothing. 
 
Near the bottom are the Options. In many cases 
checking all four far-left boxes works for what you 
might be doing. 
 
Depending on the picture, choose either 
Automatically choose color or Specify color to 
remove the background. In the case of our cat 
example, we want to remove the black in the 
background.  You can choose “automatically 
choose color” and see what the software removed.  
The parts removed were replaced with a checkered 
pattern—see picture on the previous page.  Notice 
that the black in the lower right hand corner was not 
removed.  Here you can push “Shift” on the keyboard 
and then Click on the background sections that have 
not been removed to remove these.  
 
You can also choose Specify Color, then click the 
eyedropper to select the color to remove.  
 
By selecting the “Colors” tab at the top right of the 
dialog box the menu shown to the right pops up. This 
shows all of the colors your image will have after you 
hit OK. You do not have to mess with this menu while 
making your image but it can be helpful. If you 
reduce the number of colors, it will try to merge 
similar colors or remove them automatically.  
 
This can be helpful to get the image to a reasonable 
number of colors you want to cut on the vinyl cutter. 
However, if the change in the number of colors is too 
large, you can lose important colors. 
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This shows what happened 
when we moved to six colors.  
The pinks were removed but 
multiple tans and oranges 
remained.  We can narrow 
down the colors even more by 
clicking on one color then “Ctrl 
click” similar colors we want to 
join with it. Once the similar 
colors are selected, merge them 
by clicking “merge” at the 
bottom of the screen. 
Since moving to six colors 
removed all pinks, let us try 
starting with nine colors to see if 
that works better. Keep in mind 
that we are not as concerned 
with the colors on the screen, but the lines created by those colors.  
 
Here the number of colors was changed to nine colors. Nine is still too many colors if 
your final product is smaller. (But we do like that there is not an extra line in the pink 

part of those ears.) If your 
final sticker is going to be 
larger such as 12 inches, 
than the size of pieces are 
big enough to handle this 
many colors. 

However, keep in mind your 
vinyl supply.  Do you have 
enough vinyl colors available 
for the number of colors in 
your design?  Remember, 
the more colors you have, 
the more vinyl will be used in 
your final product adding to 
the cost and the time 
consumed in affixing your 
final multi-layered sticker. 

 
 
Additional Potential Issue:  This shows an issue with our 
edited cat image.  When you zoom in you can see all the 
jagged edges.  When you discover an issue such as this, you 
will need to start again with a higher level of smoothness with 
the “Smoothing” slider. 
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Separating Colors and Order of Layers 
 
Once you have a good basic image you need to separate the colors into separate cut 
paths. Decide what order of colors should be back to front—in other words, which colors 
will be the bottom layer, next layer, etc. when you affix the stickers.  First, decide what 
the outermost color is and if that should be the back or front.  Often that color might be 
put in the back (the first layer affixed), with the inner pieces (eyes, nose, accessories), 
placed in layers above.  However, this can be problematic if there are many pieces and 
they are quite small.  Therefore, consider how best to layer the graphic you selected. 
 
Let us assume the image is a Dalmatian that has many small black spots on a white 
body. If you have ever tried to affix many little spots on a surface you may have 
discovered that it is hard to transfer each spot effectively.  In the case of our spotted 
Dalmatian, perhaps the background (or bottom layer) should be a black outline of the 
dog. Then layered on top of the black vinyl would be your white dog that has its spots 
weeded out.  This allows the black spots to show up through the upper white layer.  
 
Break the image into its various pieces by selecting the object and 
clicking Ungroup All (tool bar image for ungroup as shown here).  
 
At this point, you will want to select and delete all the little extra bits that 
you do not want. For instance in the cat picture, no matter what we tried 
while tracing the bitmap, the little gray smudge remained.  
Refer to “Selecting a Portion of your Image” on Page 24 and use the 
Freehand Pick tool to select and then delete these unwanted bits. 
 
Creating Background Layer 
 
Select all objects of the final result by using 
CTRL+A. Then copy them by using 
CTRL+C. Create a new document by 
clicking the New Document button that 
looks like a plus symbol near the top left.   
 
On the new document set the size to zero height and zero width, otherwise you will be 
cutting an unneeded border around your image.  You can change these numbers right 
above the new document button.  Then paste 
by using CTRL+V. 

With everything selected, click the Combine button:  

Then the Break Apart button:  

Then the Weld button:  
 
This should give you one single outline (or silhouette) but if not, you will 
have to do some fiddling with the curves.  Welding individual pieces 
together in steps often works to get this outline—the background color cut line. 
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Foreground Layer(s) 
 
For every color in your image, you will need to create a separate document with the cut 
lines for that color.  Create a new document like in the background layer then copy all 
objects of a single color to the new document. There are a few ways to do this.  
 

 The first option is to individually select the copy then paste each object of the 
chosen color to the new document.  
 

 Another option is to copy all objects over like in the background layer then select 
and delete each piece you do not want.  

 

 Finally, you can select the specific objects using the shift click method then 
copying them over. 

 
You will need to repeat this for each vinyl color.  Other than the background that was 
already done in the previous step. 
 
Using the Knife Tool to Separate One Color into Two or 
To Connect Lines that were “Not” Connected in the Original 
 
Perhaps the image you grabbed had an “unconnected” line that 
will be necessary to connect for proper weeding.  Or perhaps you 
want to draw a line in your image so that you can add another 
color.  Perhaps you would like your tree frog’s hands and feet 
orange but the image you selected did not have a cut line drawn at 
the wrists and ankles.  You may use the “Knife” symbol from the tool bar to slice through 
the parts that you would like an additional color or where you may need to complete a 
line.  Make sure to go the entire width with your cut line so that your line reaches the 
border.  In the case of our frog, extending over the border is not problematic because 
the cut lines extended into a part that will be removed in the weeding process. 

 
To find the Knife tool, expand the 
“Crop” tool to expose the drop-down 
box.  From there you can choose 
from Crop, Knife, Virtual Segment 
Delete, and Eraser. 
 
Although we discussed using the 
knife, you may find times where using 
the “Eraser” may also come in handy. 

 

Once you are happy with all your layers, 

you can convert them to vectors by 

clicking on OK.  Then follow the Launch 

instructions as detailed on Page 17. 
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For Makerspace Staff ONLY Section 
 
Troubleshooting 
 
Problem: The vinyl cutter is pulling up some of the design. 
 
Solution: The file likely has two shapes with that line, one interior and one exterior.  
Revisit your design and confirm only one line exists. Refer to the ‘Remove Background’ 
discussion in the CorelDraw Trace Guide section on Page 15.) 
 
Alternative Solution (ONLY for Makerspace Staff Action): There could be a piece of 
vinyl stuck to the blue tip of the tool holder (perhaps caused by the line-on-line issue 
mentioned above).  Makerspace staff may want to remove the tool holder (see below) 
and peel away any stuck vinyl. 
 
 
Problem: The vinyl cutter is cutting through both the vinyl and the paper backing. 
 
Solution:  First, check the cut settings on the vinyl cutter.  On the vinyl cutter press 
“COND/TEST” and check the “FORCE” against these settings: heat transfer vinyl: Force 
of 12; glitter vinyl: Force of 15; regular vinyl: Force of 9.   
 
(For Makerspace Staff Only)  If changing the ‘force’ does not work, staff can remove 
the cutter blade by unscrewing the holder screw and lift up, to check how much of the 
blade is exposed.  During training, makers should be warned not to touch this part of the 
machine.  Even makerspace staff should not “remove” the blade from the housing.  See 
the graphic below for the correct blade height. If you were cutting through both the vinyl 
and its paper backing, the blade is probably extended too far. It can be adjusted in or 
out, by twisting the black end without removing the blade. 
 

 

 

 
Loosen the “Tool Holder 
Screw/Knob” by turning it 
counter clockwise 

While pushing up on 
the tool holder… 

Lift the tool up and out, being 
careful NOT to touch the blade 
protruding from the blue end 
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Correct Blade Height 

 

To adjust the blade depth, twist the back end of the “Tool Holder” 

To reinstall the Tool Holder, loosen the front screw/knob, lift the retainer clip, and drop 
in the tool holder blue end down.  Push the tool all the way into the holder until its flange 
contacts the upper part of the holder and then tighten the front screw/knob by rotating 
the knob clockwise and tighten firmly but not excessively. DO NOT FORGET TO 
TIGHTEN THIS KNOB. 

 
 
Replacement machine blade/spring pairs:  Although you can purchase replacement 
blades for this vinyl cutter, it may be years before you need to change the blade.  When 
removing the blade (and its tiny spring) from the holder, it is easy to drop it and not be 
able to find it because it is so small. You may want to do this task over a pan or large 
bowl so you don’t lose the blade or it’s screw. 
 
 
Manufacturer’s Manual: Makerspace staff who want to learn more about setting blade 
length, force, speed, acceleration, and offset can also refer to the manufacturers’ 
manual. You will find an extensive trouble shooting section in Chapter 13 of the 
Manufacturer’s Manual. You may access that manual at: 
http://nlc.nebraska.gov/grants/InnovationStudios/Documents/ce6000_series_user_manual.pdf    

http://nlc.nebraska.gov/grants/InnovationStudios/Documents/ce6000_series_user_manual.pdf
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Periodic Maintenance Information (Only if Needed) 
 
If the vinyl cutter machine gets dusty or dirty, clean the machine casing (the grey outer 
shell of the machine) using a dry cloth that has been moistened with a neutral detergent 
diluted in water.  NEVER use thinner, benzene, alcohol, or similar solvents to clean the 
casings, as they will damage the finish. 
 
Clean the cutting mat area (the black part of the machine) using a dry cloth.  In the case 
of stubborn stains, you can moisten the cloth with that diluted detergent. Take care to 
not cut yourself on the blade. 
 
Clean the plotter’s media (material) sensors using a cloth moistened with a neutral 
detergent diluted in water.  NEVER use thinner, benzene, alcohol, or similar solvents as 
that will damage the sensors. 
 
If and only if the Y rail sliding surface gets dirty, gently wipe the dirt away with a clean, 
dry cloth.  DO NOT WIPE ALL THE LUBRICANT OFF.  Note the Y rail sliding surface 
has a lubricant on it so be sure not to wipe off all the lubricant. 
 
Never lubricate the mechanisms of the plotter. 
 
Some makerspaces will cover their machines with a clean cloth or plastic sheet when it 
is not in use. 
 
Your vinyl cutter should not be stored in direct sunlight or in very warm temperatures. 
 
 

Proper Storage Humidity and Temperature Levels 
 
Vinyl should be stored in areas that are not too cold, too hot, or too humid/damp.  
Relative air humidity between 50% and 60% and temperature around 75°F is best.  Do 
not let the storage area temperature to drop below 64°F and do not store vinyl in direct 
sunlight.  Do not have vinyl stored too close to radiators or right next to air vents. 
 
 
 
 
 
 
If you need a “Word” version of this document (rather than the PDF that is online), you 
may contact JoAnn McManus at the Nebraska Library Commission at 
joann.mcmanus@nebraska.gov 
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